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Power Adapter & Cable Printer

[ Fio. 2 PRINTER COMPONENTS

Release Latch.

User Manual

USB Cord

Power Supply Port

&

USB Cable Port
Power Switch(O=off,I=on)

WARNING!

STEP 1 PRINTER SETUP

STEP 3 PRINTING SETUP

1.Ensure the printer is OFF 2.Connect the power cable

3.Connect the USB cable

4.Turn the power ON

STEP 2 DRIVER INSTALLATION FOR WINDOWS

Please insert the included USE into your computer.

A dialog box may appear.

If it does,select Open folder to view files.

If a dialog box does not appear,open Windows Explorer and select the flash
drive on the left side of the window.Run "Beeprt Printer Driver Setup.exe",
follow the installation steps.

You can also download the latest driver here:www.beeprt.com
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FOR WINDOWS

1. When installation finished,open your
printer page by typing Control Panel
ntp the search box on the taskbar.Click
the Control Panel search result.In

See what's printing
Set as default printer
Printing preferences

Control Panel,click Hardware and e
Sound then Devlces and Printers. Beeprt BY-244 Create shortcut

Right click on your newly installed % Remove device
BY-426 Label printer and choose ioubleshet
Printing preferences. Properties

2.Go to the Page Setup tab on the top

of the dialog box.you can change Beepr
setting of printer, like paper size speed, |Paper/Quality| Page Setup |About]
darkness...

Layout| Papacunity Page Setup b

3.From the Name drop-down menu,

select the size of your label.A 4"x6"label sior

s approximately 100x150mm.Click OK to
save your settings and continue to Step 4

on the reverse of this page. i

wnzenn

MAC PRINTING SETUP

For MacOS computers, please see"MAC PRINTING SETUP"on
page 8 of these instructions.

STEP 4 LABEL SETUP
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1.Ensure the printer is OFF.

2.Pull the release latch to
open the cover.

3.Load the labels.

4.Close the cover carefully.

Make sure the orange guides
are touching the label sides.
The pintable part of the label
should be facing up toward you.

5.Turn the power ON and
wait 5 seconds for the printer
to initialize.

6.Press and hold orange feeder button until you hear one short beep,take away
your finger, the printer will begin automatic label identification. Once the printer
stops,it will have identified your label size.The next time you want to put labels
into the printer,instead of opening the printer,you can simply feed labels into the
back of the printer.

MAI NTE NANCE CLEANING THE PRINT HEAD,

The printer head is a sensitive part of the printer and can be found on the upper
part of the printer when open.

Caution:While the printer is running the printer head can be very hot.

1.Ensure that the power switch is OFF,remove the power cord,and open the
cover as outlined above in step 4. wait several moments to ensure that the printer
head cools down.

2.Completely clean the printer head using an alcohol swab like the one provided.
Any 70% Isopropy! Alcohol pad would work . Please do not use water.

3.Wait 2-3 minutes until the alcohol has completely dried, then close the cover.
4.Connect the power cord and print a test page to check if it is clean.

PRO TIPS

» Anytime you'd like to change your label size,run the automatic label
identification by pressing and holding the feeder button until you hear one
short beep.

« Press the orange feeder button on the printer to skip a blank label.

* To run a self-test,press and hold the feeder button until you hear two short
beeps.

= Avoid using poor quality labels as they can damage the printer.

» Regularly clean the printer head as outined above,under MAINTENANCE.

« If paper is jammed,turn off the printer,and allow the printer head to cool
down.Open the cover and ensure that the rubber is clean.If it is dirty,use
alcohol pad to clean it.Allow the area to dry before turning the printer back on.
= Insert the printer's USB into the USB port on your computer every time

you plug it in.This will avoid creating duplicate copies of the printer on your
computer.

SAFETY s

COLOUR OR STATUS
OF LED BUTTON

EXPLANATION SOLUTION

Printer is running

Green
normally

None. Printer will
automatically resume once
the printer head cools down.

Printer Head is

Flashing Green overheated

Ensure that the labels are loaded
correctly.You may need to run
automatic label identification
(point 6 in step 4).

Flashing Red

1.0ut of paper
(every 2 seconds)

2.Wrong size paper

Flashing Red Printer cover is not
(2 times per second) fully closed

Check that the printer
cover is completely closed.

PRINTER specs

Direct Thermal
Resolution.
Max Printing Speed ..
Paper Width
Paper Thickness.
Power Adapter.
Printing Life......
Operating Temperature.
Environment Humidity...
Storage Temperature
Environment Humidity. ....5-95%
Connection... USB or USB+Bluetooth

« The printer head can become very hot after printing labels .Do not touch the
printer head until it has cooled.
« Do not bend the power cord excessively or place objects on the cord. This could
result in fire or electocution.
* Keep the printer out of reach of children.
* Use only approved accessories and do not try to disassemble or repair the unit
by yourself.
* Keep the printer away from water and other objects that may destroy or
damage the device.

Printer should remain unplugged when not in use for long periods of time.

BLUETOOTH FUNCTION

For Windows

1.0pen bluetooth device settings,scan and select name"Beeprt BY- 244 _XXXX"
to pair. Input PIN code: 0000 ("BY-244 _XXXX_LE"is BLE mode)

Manage Bluetooth devices

Your PC is searching for and can be discovered by Bluetooth
devices.

(=W Beeprt BY-244 _BD4C
bl Ready to pair

2.If you connect bluetooth in Windows system,you need check COM port after
pairing(Fig.1)

© Bluetooth Settings @ X

Options COM Ports  Hardware

This PC is using the COM (serial) ports listed below. To
determine whether you need a COM port, read the
documentation that came with your Bluetooth device.

3.Run driver setup program and select this COMXx to setup.

Beeprt Printer Driver Setup v2.4.0 - @ X

Select the name and port of printer driver

Printer Modek:
Driver Name: |Beeprt BY-244. [ME==stat=y
_— & Getusaport |
L [Sectvspet ¥
COM etting
soudrate: [1160M2 NONE
atabits: . L =
Diahte LPTI: e
Flow Control: |LPT3: . ~

4.0Open "Ports” in driver properties,check this COM port is currect(Fig.3).

S Beeprt BY-426BT Properties

General Sharing Ports  Advanced Color Management Security  Device

% Beeprt BY-244

Print to the following port(s). Documents will print to the first free
checked port.

Description Printer ~
Printer Port
Printer Port
Printer Port

Po Direction ~ Name - Seralport
Serial Port
[€e]VE] Outgoing  Beeprt BY-244 _BD4C Beeprt BY-244
CcoM4 Incoming  Beeprt BY-244 _BD4C
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3. 4. 5.

FBA Print rorios sandroid

Send PDF file to mobile Select copy to”FBA Print”, First use of "FBA Print"

social software,such as then you can print it. Click"More" and add
WhatsApp,then open "FBA Print"
1.please search FBA Print on Apple Store this file.
. FeA prind © Cancel
L o ware
Note: . | e <~O S T ;,:
After Android 6.0,to scan for low-power : oass
Bluetooth devices, APP need to have permission il T e e
to access the device’s location.However,the e — . i
APP will not use your location information, [ i JIIII
turning on thl§ permission is only to scan for e ;ﬁwELE‘L
Bluetooth devices. alwie ritlylulilo]p - (9}
l =
PO =
15 won e S = - — —_—— =
printers. + 0 ® ¢ Cancel Cancel
oo SR y—
2.0pen app and connect Bluetooth
1 JA
10 1
MAC PRINTING SETUP FOR MAC OS - — "
(& B HO el

Please insert the included USB into your computer.A flash drive icon will

usually appear on the desktop.If a dialog box does not appear, open Finder
and select the flash drive on the left side of the window.

You can also download the latest driver here:
http://help.beeprt.com

Let us start to install beeprt printer driver on Mac now.
Beeprt requires OS X 10.9 or latest.

Double click the download file, "Beeprt-Mac-Latest-Driver.dmg"if you see a
warning shown below. (if you don't see this warning,you can skip these two
steps)

. “BeeprtPrinter_v1.3.pkg" can’t be opened
because it is from an unidentified developer.

A Your security preferences allow installation of only
apps from the App Store.

"BeeprtPrinter_v1.3.pkg" is on the disk image "“Beeprt-
Mac-Latest-Driver.dmg". Safari downloaded this disk
image today at 15:16 from help.beeprt.com.

@

i

Open "System Preferences”,and click | o= &
on "Security & Printing”

iCoud  imemet  Sofwwe  Netwok  Bustooth  Extensons  Sharing

(If you don't see the warning, you can skip this Accounts  Update

step) N ® & = @

TchiD  Uses&  Panal  SM  DseATme Tme  Accessbliy
Groups  Contls Machne

FashPlayer  Java

Securly 8 Prvacy [ ]|

I Freveur  Frowal privecy

Alogin password has been setfo this ser _ Change Passord..

immaitaty [
Snow  message when the screenislocked et Lok Messaoe
Click on "Open AnyWay" button.
(If you don't see the warning, you can skip this
Allow apps downloadied from: 2
+ Appstore \ step)
Open Aryway
{rom an deniied doveloper
e o

We highly recommended that you open installation guide pdf file firstly, so you
can follow the steps.
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Double click "BeeprtPrinter_v1.3.pkg" to begin to install driver.

eoe [ Beeprt-Mac-Latest-Driver
1 « Open Installation Guide 2 . Open and Install Driver 3 . Print Sample Label
= >
=
[T
<
How to install Beeprt sample.pdf
printer driver for MacOS.pdf
Ifyou need help, please visit : help.beeprt.com
or you can cantact us with WhatsApp / Skype / Wechat / Line : +8618136659593
Emal: support@beeprt.com T

Follow the installation steps until you see " The installation was
successful" window.

X X®) ‘@ Install BeeprtPrinter Ver1.3

The installation was completed successfully.

« Introduction

© Destination Select
o Installation Type
o Installation

S Summeny The installation was successful.
The software was installed.

Open "System Preferences" and click on "Printers and Scanners".

oo <[> ) System preferences Q search
T pTmn OE fom oo S e e
s Comel ‘arogen sy
BT e N &
= e B e el e s o e Y e
el A fi
e A o e e s e

Accounts  Update

® 0 ® 0 & © @

TouchiD  Users&  Parental Sii  Date&Time  Time  Accessibility
Groups  Controls Machine

-

Flash Player

Click "+" to add a new printer.

Printers & Scanners Q Search

8, Beeprt B! Beeprt BY-244

way” © Offl d ﬁ; Open Print Queue...

ﬁ Beeprt BY-244 e |
- HP LaserJet Professio... - o

© Offline

=~ Label Printer-2502-58... Location: ED

Lo o Paused

Kind: Beeprt BY-244 Label
Status: Offline

Share this printer on the network  Sharing Preferences...

Default printer: ~ Last Printer Used

o)
5

Default paper size: A5
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Click on "Beeprt BY-244"(or other model of Beeprt) ,and choose
"Select Software" in the drop down menu.

LK Add
- Q Search
1P Windows Search
Name ~ Kind
Beeprt BY-244. pusb.

Name: | Beeprt BY-244

Location: | EDi

Usq v Choose a Driver..

Auto Select
Select Software...

| otner... I

Input "Beeprt" to search and choose,then click "OK".

00 @ Printer Software

Q Beeprt (]

Beeprt BY-244 Label

Beeprt Printer

Click on "Add" to finish.(if you see a warning windows, click "repair" to
continue)

coce Printer Software

Q Beeprt J

Beeprt BY-244Label
Beeprt Printer

Cancel

SETTI NG THE LABEL SIZE

Open a PDF file in Adobe Reader (the recommended program is Adobe Acrobat
Reader DC)
On the top menu, select file and the select Print.

Cancel
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HERE’S AN IMPORTANT TIP!
Orientation:
° Auto portrait/landscape
) Portrait DO YOU HAVE TWO LABELS ON A PAGE LIKE THIS
" Landscape (85 x 11 inCh) ?
Page Setup... | Printer... ”HI%@%NI

To define a new label size,choose Manage Custom Sizes in the Paper Size
dropdown menu. Click”+" to add a size.set the size,and click OK

Box 1 of 1-49.75Ib

PLEASE LEAVE THIS LABEL UNCOVERED

to save.
100x190 Paper Size: 103.72mm | 2000.25 mm|
Width Height
Non-Printable Area:
Beeprt BY-244 B
[ mm; g
1 0 mm Iop 0 mm] v
Left i} Right
Bottom
= z
+ —  Duplicate 2 o
N=
2 Canics!, ~ .
S —— &
H © i
v: - N g :
e 3 5o s .
n — 3 g
. N=
B iy 3:
] g3
b O¢ H
HE IE o B
L =¥ E
Bk & =
BELS. [WmAONSIMWGAT  50LBS  10F1| FBA Box 1 of 1 -49.75lb
I A — o e o o

Open the PDF in Adobe Reader
From the top panel,select View > Rotate View > Clockwise
so that the labels are side by side.

Document Tools Window Help

Go To : I_v [ | Fina c
»

Zoom
Page Display

Reading Mode

Eull Screen Mode Ctrl+L

Menu Bar F9
= Toolbars > E
1| Navigation Panels 4 §
O e Weahis Ctl+5 g
E
Tracker... §
Automatically Scroll Shift+Ctrl+H i

Read Out Loud »
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P

SHIF TO:
MAZON COMAZDC, INC. Uni
50 was sCouE 1
T HH“HH | ‘| ‘|“H|“‘“H“”H
FBA15GIR5CPLUO000OT -1
W AZ 856 7-20 T
S ——

PLEASE LEAVE THIS LABEL UNCOVERED

s mm

UPS GROUND

TRACKING #: 17 SRF 184 03 8419 4749

sivas _wensians It

BILLING: P/P

Next, from the top panel,select Edit > Take a Snapshot. Then click and drag
over one of the labels.

21

Box 1 0of 1 -4975Ib

FBA1SGIRECPLUDOO001

2%
—

PLEASE LEAVE THIS LABEL UNCOVERED

Click Print

Make sure that:

You select the Label Printer from the Printer menu.
Shrink oversized pages is selected.

Choose paper source by PDF page size is uncheked.
Auto portrait/landscape is selected.

Go to Page Setup ..and ensure that your page size of your
label.A 4"X6"label is approximately 100x150mm.

Happy Printing!
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FCC Warning

This device complies with part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) This device may not cause harmful interference, and (2)
this device must accept any interference received, including interference that may
cause undesired operation.

Any Changes or modifications not expressly approved by the part responsible for
compliance could void the user’s authority to operate the equipment.

Note: This equipment has been tested and found to comply with the limits for a

Class A digital device, pursuant to part 15 of the FCC Rules. These limits are designed
to provide reasonable protection against harmful interference when the equipment
is operated in a commercial environment. This equipment generates, uses, and can
radiate radio frequency energy and, if not installed and used in accordance with the
instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful
interference in which case the user will be required to correct the interference at his
own expense.

FCC Radiation Exposure statement:

This equipment complies with FCC radiation exposure limits set forth for an
uncontrolled environment. This equipment should be installed and operated with
minimum distance 20cm between the radiator & your body.

This transmitter must not be co-located or operating in conjunction with any oter
antenna or transmitter



